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Preface

Congratulations to your new PrimuX ISDN card, a high performance adapter for professional
communications. This manual will guide you through installation and configuration of the
PrimuX ISDN adapter.

We wish you lots of success with our ISDN adapters!

Sincerely, Gerdes AG
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Copyright notice

Copyright (c) 2000-2014 Gerdes Aktiengesellschaft, Meckenheim, Germany. All Rights Reserved.
You may not reproduce this document in whole or in part without permission in writing from
Gerdes Aktiengesellschaft.

All contents of this document are subject to change without notice and do not represent a
commitment on the part of Gerdes Aktiengesellschaft. Reasonable effort is made to ensure
the accuracy of the information contained in the document. However, due to ongoing product
improvements and revisions, Gerdes Aktiengesellschaft does not warrant the accuracy of this
information and cannot accept responsibility for errors or omissions that may be contained
in this document. It is possible that the use or implementation of any one of the concepts,
applications, or ideas described in this document, in marketing collateral produced by or on
web pages maintained by Gerdes Aktiengesellschaft or its subsidiaries may infringe one or more
patents or other intellectual property rights owned by third parties. Gerdes Aktiengesellschaft
does not provide any intellectual property licenses with the sale of PrimuX products other than a
license to use such product in accordance with intellectual property owned or validly licensed by
Gerdes Aktiengesellschaft or its subsidiaries. More detailed information about such intellectual
property is available from Gerdes Aktiengesellschaft's legal department at Bergerwiesenstr. 9,
D-53340 Meckenheim, Germany.

Gerdes Aktiengesellschaft encourages all users of its products to procure all necessary intellectual
property licenses required to implement any concepts or applications and does not condone or
encourage any intellectual property infringement and disclaims any responsibility related thereto.
These intellectual property licenses may differ from country to country and it is the responsibility
of those who develop the concepts or applications to be aware of and comply with different
national license requirements. In the United States, patents which may need to be licensed for
some applications or concepts include but are not limited to U.S. Patent Nos. 5,488,651 and
5,291,546. The software referred to in this document is provided under a Software License
Agreement. Refer to the Software License Agreement for complete details governing the use of
the software.

All names, products, and services mentioned herein are the trademarks or registered trademarks
of their respective organizations and are the sole property of their respective owners. Gerdes,
Gerdes Aktiengesellschaft and PrimuX are registered trademarks or trademarks of Gerdes Akti-
engesellschaft or its subsidiaries.

To contact Gerdes Customer Support, refer to the *Customer Services' section in the prin-
ted guide that came with the Gerdes product which you purchased or visit our Web site at
www.primuxisdn.de.
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License Agreement

This is an Agreement between you the Company and your Affiliates (referred to in some instan-
ces as "You" and in other instances as "Company") and all your Authorized Users and Gerdes
Aktiengesellschaft ("Gerdes").

YOU SHOULD CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS BEFORE INSTALLING
OR DOWNLOADING THE SOFTWARE. IF YOU AGREE WITH THESE TERMS YOU MAY PROCEED
WITH THE DOWNLOAD OR INSTALLATION OF THE SOFTWARE. IF YOU DO NOT AGREE WITH
THESE TERMS, PLEASE RETURN THE PACKAGE IN "AS NEW" CONDITION (INCLUDING DOCU-
MENTATION AND BINDERS OR OTHER CONTAINERS) AND YOUR MONEY WILL BE REFUNDED.
DOWNLOADING OR INSTALLING THE SOFTWARE CONSTITUTES YOUR ACCEPTANCE OF THESE
TERMS AND CONDITIONS. YOU ASSUME RESPONSIBILITY FOR THE SELECTION OF THE PRO-
GRAM TO ACHIEVE YOUR INTENDED RESULTS, AND FOR THE INSTALLATION, USE, AND RESULTS
OBTAINED FROM THE PACKAGE.

Copyright

The enclosed Software ("Program") and documents are owned by Gerdes Aktiengesellschaft
("Gerdes") and its suppliers and are protected by copyright laws and international treaty provisi-
ons. Therefore, You and your Authorized Users must treat the Program and documentation like
any other copyrighted material except as expressly permitted in this License Agreement.

License

Under the terms and conditions of this License Agreement:

e You may install and use one copy of the Program on a single-user computer, file server, or
on a workstation of a local area network, and only in conjunction with a legally acquired
Gerdes hardware product;

e The primary Authorized User on the computer on which the "Program" is installed may
make a second copy for his/her exclusive use on either a home or portable computer;

e You may copy the Program into any machine readable or printed form for backup or
modification purposes in support of your use of one copy of the Program;

e You may make one copy of Gerdes's documentation provided that all copyright notices
contained within the documentation are retained;

e You may modify the Program and/or merge it into another Program for your use in one
computer; (any portion of this Program will continue to be subject to the terms and
conditions of this Agreement);
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e You may transfer the Program, documentation and the license to another eligible party
within your Company if the other party agrees to accept the terms and conditions of this
Agreement. If You transfer the Program and documentation, You must at the same time
either transfer all copies whether in printed or machine readable form to the same party
or destroy any copies not transferred; this includes all modifications and portions of the
Program contained in or merged into other Programs;

e You must reproduce and include the copyright notice on any copy, modification or
portion of the Program merged into another Program;

e You may not rent or lease the Program. You may not reverse engineer, decompile or
disassemble the Program. You may not use, copy, modify or transfer the Program and
documentation, or any copy, modification or merged portion, in whole or in part, except
as expressly provided for in this License Agreement;

e If You transfer possession of any copy, modification or merged portion of the Program
or documentation to another party in any way other than as expressly permitted in this
License Agreement, this license is automatically terminated.

Upgrades

If the Program is provided as an upgrade and the upgrade is an upgrade from another software
product licensed to You and Your Authorized Users by Gerdes, the upgrade is governed by the
License Agreement earlier provided with that software product package and the present License
Agreement does not grant you additional license(s).

Term

The license is effective until terminated. You may terminate it at any time by destroying the
Program and documentation together with all copies, modifications and merged portions in
any form. It will also terminate upon conditions set forth elsewhere in this Agreement or if you
fail to comply with any terms or conditions of this Agreement. You agree upon such termination
to destroy the Program and documentation together with all copies, modifications and merged
portions in any form.

Limited Warranty

The only warranty Gerdes makes is that the medium on which the Program is recorded will be
replaced without charge if Gerdes, in good faith, determines that it was defective in materials or
workmanship and if returned to your supplier with a copy of your receipt within ninety (90) days
from the date you received it. Gerdes offers no warranty for your reproduction of the Program.
This Limited Warranty is void if failure of the Program has resulted from accident, misuse, abuse
or misapplication.
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Customer Remedies

Gerdes's entire liability and You and Your Authorized Users exclusive remedy shall be, at Gerdes's
option, either (a) return of the price paid or (b) repair or replacement of the Program that
does not meet the above Limited Warranty. Any replacement Program will be warranted for the
remainder of the original Warranty period.

No Other Warranties

Gerdes disclaims all other warranties, either expressed or implied, including but not limited to
implied warranties or merchantability and fitness for a particular purpose and the warranty
against latent defects, with respect to the Program and the accompanying documentation. This
limited warranty gives You specific legal rights. You may have others, which may vary from
jurisdiction to jurisdiction.

No Liability for Consequential Damage

In no event shall Gerdes or its suppliers be liable for any damages whatsoever (including without
limitation, damages for loss of business profits, business interruption, loss of information, or
other pecuniary loss and indirect, consequential, incidental, economic or punitive damages)
arising out of the use of or inability to use this Program, even if Gerdes has been advised of the
possibility of such damages. As some jurisdictions do not allow the exclusion or limitation for
certain damages, some of the above limitations may not apply to You or your Authorized Users.

Limit of Liability

Gerdes's entire aggregate liability under any provision of this agreement shall be limited to the
amount actually paid by You for the affected Program.

Right to Audit

If this Program is licensed for use in a Company, your Company agrees to keep all usual and
proper records and books of accounts and all usual proper entries relating to each reproduction
and Authorized User of the Program during the term of this Agreement and for a period of three
(3) years thereafter. During this period, Gerdes may cause an audit to be made of the applicable
records in order to verify Your compliance with this Agreement and prompt adjustment shall be
made to compensate for any errors or omissions disclosed by such audit. Any such audit shall
be conducted by an independent certified public accountant selected by Gerdes and shall be
conducted during the regular business hours at Your offices and in such a manner as not to
interfere with Your normal business activities. Any such audit shall be paid for by Gerdes unless
material discrepancies are disclosed. For such purposes, "material discrepancies" shall mean three

6 Customer Remedies



percent (3%) or more of the Authorized Users within the Company. If material discrepancies
are disclosed, Your Company agrees to pay Gerdes for the costs associated with the audit as
well as the license fees for the additional Authorized Users. In no event shall audits be made
more frequently than semi-annually unless the immediately preceding audit disclosed a material
discrepancy.

Supplementary Software

Any Supplementary Software provided with the Gerdes Program referred to in this License
Agreement is provided "as is" with no warranty of any kind.

U.S. Government Restricted Rights

The Program and documentation are provided with RESTRICTED RIGHTS. Use, duplication or
disclosure by the U.S. Government is subject to restrictions as set forth in subparagraph c)
1) i) of The Rights in Technical Data and Computer Software clause at DFARS 252.227-7013
or subparagraph c) 1) and 2) of the Commercial Computer Software-Restricted Rights at 48
CFR52.227-19, as applicable.

Contractor/ manufacturer is:

Gerdes Aktiengesellschaft

Bergerwiesenstr. 9, D-53340 Meckenheim, Germany
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News and Updates

You can find up-to-date information, software and add-on products for your PrimuX card on
the internet at

www.primuxisdn.de

We highly recommend that regularly check this web site for updates or upgrades.

Customer Services

Your PrimuX ISDN adapter is very easy to install and use. This manual should contain all
information you need. As every PC is different, it is always possible that problems occur that are
due to specific configurations of your PC.

Answers to frequently asked questions and tips concerning ISDN or the internet are available on
our web site

www.primuxisdn.de

If you can't find the answer to your questions there please call or mail our service team:

Phone + 49 2225/916030
Fax =~ +492225/91601899
Mail  service@gerdes-ag.de

News and Updates


http://www.primuxisdn.de
http://www.primuxisdn.de
mailto:service@gerdes-ag.de

Software

Requirements

MS Windows

The driver software for the PrimuX adapters can be used on Windows XP, Windows Server
2003, Windows 7, 8, 8.1, 2008 Server and 2012 Server.

Linux

The driver software for the PrimuX adapters can be used with a Linux kernel version 2.4.x
(2.4.10 or higher) or 2.6.x and 3.x. The CAPICFG and TRACER tools need the GTK libraries 1.2
or higher.

Please note that it is possible to use the GUI configuration tool to configure console-only PC
connected to a LAN by using the RMTCAPI daemon. As these tools are TCP/IP based it is even
possible to configure Linux PCs from Windows or the other way around. Tools like HylaFAX (using
CAPI4HylaFAX), CapiSuite or pppd (using capiplugin.so) can be used without any modifications.
kisdnwatch is supported but needs a patch in the manufacturer check (replace "avm" by "gerdes").

Installation

MS Windows

Please install the PrimuX software before adding the PrimuX adapter. This way you can
configure your PCs first and install different PrimuX adapters at a later time.

Run primux.exe from the driver CD. Follow the instructions on screen. During installation
Windows will ask if you trust software from Gerdes AG. Please acknowledge these prompts by
clicking Yes. After the installation has finished all components needed for the PrimuX adapters
have been installed.

After installing/connecting your hardware Windows will show a New hardware found dialog.
Please select Install the software automatically (Recommended) and click Next. For each added
ISDN WAN MiniPort a New hardware found dialog will appear. Select Install the software
automatically (Recommended) and click Next each time. Acknowledge the following Hardware
has not passed Windows Logo testing message by clicking Continue Anyway.

Deinstalling the drivers

To deinstall the driver software for your PrimuX adapter select Start / Programs / PrimuX ISDN
/ Remove software and follow the instructions on screen.
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WARNING: The deinstallation process will remove all installed PrimuX adapters whether they
are currently active or not. All driver settings will be lost. To reuse your settings at a later time
you have to save them before deinstallation. After deinstallation you need to reboot your PC to
completely remove all driver files.

Linux

Introduction

Because of dependencies between the driver and the kernel version used on your machine the
OS dependent part of the driver has to be compiled during installation. The necessary kernel
include files should have been installed by your distribution.

The PrimuX software doesn't need any distribution specific configuration applications (i.e.
YaST2 with SuSE). These application won't be able to configure the PrimuX adapters and in
most cases won't even show them in their list of installed hardware. You can configure your
PrimuX adapter using CAPICFG.

Installation

To install the driver software run setup . sh from the installation CD. Depending on your system
(graphical desktop or console) a compatible installation routine will start up:

e The text mode installation asks you to answer a few questions. Please keep the default
settings by simply pressing ENTER. Based on these settings the driver and utilities will be
installed, compiled and loaded

e In the GTK based installation program simply click Begin Install. The driver and utilities
will be installed, compiled and loaded

As the PrimuX drivers are not licensed under the GPL, recent Linux kernels may show a warning

message (tainted kernel) when loading the drivers. You can safely ignore this message, though.
Deinstalling the drivers

To deinstall the driver software for your PrimuX adapter please enter

/usr/lib/primux/uninstall

at a bash prompt. This will remove all files and settings made by the installation process.

WARNING: The deinstallation process will remove all installed PrimuX adapters whether they
are currently active or not. All driver settings will be lost. To reuse your settings at a later time
you have to save them before deinstallation.
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CAPICFG

On the left hande side of the CAPICFG main window a list of all available services and ISDN
adapters is shown. The right hand side will show settings for the selected item on the left hand
side.

The 'File' menu

T Pl 18 e

New

This command will create a new empty configuration. CAPICFG will query you to save your
changes before deleting the current configuration.

Open active configuration

This command loads the current configuration from the driver. CAPICFG will query you to save
your changes before deleting the current configuration.

Open remote configuration

This command opens a connection to a PrimuX driver loaded on another PC and loads its
configuration. On the other PC the RMTCAPI daemon has to be started for this to work. CAPICFG
will query you to save your changes before deleting the current configuration.
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Please input the IP address of the remote PC and the port used by the RMTCAPI daemon. Then
click on Ok.

Open

This command loads a previously saved configuration from disk. CAPICFG will query you to
save your changes before deleting the current configuration.

Save

This command saves the current configuration to disk.

Save as...

This command saves the current configuration to disk using a new or different file name.

Activate

This command reconfigures the driver with the current configuration. If you originally loaded
the configuration using the Open remote configuration command the driver on the remote PC
will be reconfigured.

Exit

This command will close the program. CAPICFG will query you to save your changes before
deleting the current configuration.

The 'Edit' menu

w
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Cut

Copy selected data to the clipboard and delete it from the configuration.

Copy

Copy selected data to the clipboard.

Paste

Insert clipboard contents into the configuration.

Delete

Delete selected data.

The 'Insert' menu
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CAPI Service

The CAPI service can be added only once. It enables access to the ISDN adapters using the CAPI
2.0 (and CAPI 1.1) interface.

RAS (WAN miniport)

The WAN miniport can be added only once. It enables access to the ISDN adapters for internet
dial up services. On Windows additional devices will be created that can be used with the
Windows RAS service. On Linux you can access adapters configured for RAS by using different
controller numbers (129, 130, ... instead of 1, 2, ...).

Add adapters

The lower part of this menu contains a list of all adapter types supported by the driver. You
can add these adapters to a configuration manually. This way you can preconfigure a PC before
installing the hardware for real.
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The 'View' menu
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Toolbar

Toggle the toolbar display.

Statusbar

Toggle the status bar display.

Advanced

Toggle availability of the advanced settings page. This page shows some technical settings that
you can modify on your own risk...

The 'Help' menu
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Content

Open the contents page of the online help.

Context help

Open the help page for the current selection.
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CAPI Service

These pages show information about the features supported by the CAPI service. You can use
this list to check if the driver supports specific features some applications require.

General
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OfW X |43 78

Bum| 38T | e [fron st e i

This page shows the manufacturer data, version and revision information and an optional serial
number the adapter reports to applications. Furthermore you will find the number of controllers
and B channels configured for the CAPI service here.

Features

The CAPI service reports supported features in a standardized way. You will find a list of supported
features on this page.

Protocols
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The CAPI service reports supported B channel protocols in a standardized way. You will find a
list of supported protocols on this page.
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RAS service
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On this page you will find the number of channels available for internet dial up connections.

Adapter settings
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On this page you will find some general information about the selected adapter.

Some adapter types (i.e. adapters connected to the serial port) need additional settings. These
settings will be shown on this page, too.
Port settings

An ISDN adapter supports one or more ISDN ports. For every port you will need to specify some
information about the ISDN line it is connected to.

General

i e i

T Pl Im e
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Line type Some technical data about the kind of line this port can be connected to.

Switch Type You can get information about the switch and interface type from your phone
provider. As most countries today use the ETSI-DSS1 standard the default setting should be a
good start.

Interface Type ISDN lines in private homes usually are of the Point-to-Multipoint (PTMP) type.
If the line is configured for a PABX it may be a Point-to-Point (PTP) line. Please ask your phone
provider if you are not sure what kind of line you have.

Inbound calls This settings should be 'No Phone Numbers' at first. This way all inbound calls
will immediately be signaled to the application software. When you use some software that
will always accept all calls regardless of the called party number you can enable a filter in the
driver. This way the application will only be notified of calls that matched your settings. The MSN
(Multiple Subscriber Number) setting allows specification of those numbers the driver should
pass through; the Range of Extensions setting allows selection of a range of numbers in a PTP
setting.

Diagnostics By pressing this button you can check if the line can connect to the phone company
using the selected settings. Please keep in mind, that all your current settings will be activated
in the driver for this test.

List of MSNs

ST T LW wa

On this page you can add up to 10 numbers to the list which the driver should pass through.

Dial-In numbers

On this page you can specify a lowest and a highest extension. The driver will pass all calls
directed to an extension in this range to the application. Both numbers have to be of the
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same length and the lowest extension has to be numerically smaller than the highest extension.
Depending on the port it may be necessary to add a trunk number to both numbers.

Advanced

The advanced settings are quite technical and require some basic knowledge of ISDN hardware.

Adapters for the SO bus offer the following advanced settings:

Direct Dial In (NT2) If you set this to Yes the driver will automatically generate a SETUP ACK
message on incomplete numbers. This way there won't be a timeout when the caller manually
dials a long extension number.

The default on a PTMP line is No, on a PTP line it is Yes.

TEI Here you can select the TEI value to use for layer 2 connections. The default on a PTMP line
is Automatic, on a PTP line it is 0.

Layer 2 Connect Mode This setting specfies how the layer 2 connection is managed. On PTMP
lines the default is On Demand; with this setting layer 2 will be established when a call is being
made and released as soon as the last call is terminated. On PTP lines (and on PRI lines) the
default is No Disconnect; with this setting layer2 will be established when a call is being made
but it will never be (actively) released. With the Permanent setting layer 2 will be established
immediately when a layer 1 connection is established.

Cause Value for Rejected Calls Here you can specify how the driver handles inbound calls that
are not signalled to any application. Usually those calls are simply ignored but in special cases
it may be necessary to reject them with a specific cause value (i.e. for call redirecting services to
work).

Voice Coding Here you can specify whether the driver should use the a-Law or u-Law coding
standard for generated tone signals (fax modulation, DTMF etc.). The default setting Protocol
default sets the coding standard based on the selected switch type; usually there should be no
need to manually change this setting.

Device Mode This setting selects if the ISDN port should be activated immediately upon loading
the driver (setting Default) or onyl when an application is registered with the driver (setting Hunt
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Group). The Hunt Group setting makes sense when a PBX can sense a deactivated line and will
automatically distribute inbound calls only to active lines.

Operating Mode [only available on adapters with NT mode support] Here you can select if the
port should be used as terminal equipment (setting TE- Terminal Equipment (recommended))
or network termination. If you select NT - Network Termination [simple] the driver will handle
almost all differences between NT and TE mode so that there are virtually no software changes
necessary. The driver will generate all progress tones at the appropriate times without application
intervention. These features can be disabled by selecting NT - Network Termination [full]. Now
the application has complete control over the ISDN line (for this to work you will need to change
your software). You will find more information about the NT mode support in the chapter NT
Mode.

Adapters for the primary rate interface offer some additional settings:

T Bl

Fractional T1/ET Line An E1 line usually supports 30 B channels numbered 0 to 29 (T1: 23
channels). Fractional lines offer a reduced number of channels for a lower price. If you use a
fractional line please select Yes and specify the available channels.

No. of Available B Channels Please enter the number of available channels on your fractional
line (you can request this information from your phone company).

Lowest B Channel Please enter the number of the lowest available channel on your fractional
line (you can request this information from your phone company).

Layer 1 Framing Here you can select what line framing to use. The Procotol default setting selects
the framing depending on the selected switch type and should usually be correct. If your phone
company specifies a different framing please choose the corresponding setting.

Layer 1 Coding Here you can select what line coding to use. The Procotol default setting selects
the coding depending on the selected switch type and should usually be correct. If your phone
company specifies a different coding please choose the corresponding setting.
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Service Settings

You can specify what services should be available on each port. If you put a S2M and a SO
adapter into your PC you could configure the S2M for the CAPI service and the SO adapter for
the RAS service so it could be used for remote access. To configure a port for a specific service
just drag the corresponding service symbol onto the port and drop it. To remove a service from
a port simply highlight it and select Delete from the Edit menu.

General

Number of B Channels This settings enables you to reduce the number of channels a service is
allowed to use. This way you could allow only 29 channels of a PRI port for the CAPI service and
leave one channel available for the RAS service. This way you can be sure that you can always
dial in to your PC.

Inbound Calls If you want to use a port for outbound calls only, please select No Calls. Inbound
calls then will automatically be ignored or rejected according to the Cause Value for Rejected
Calls setting. When you select All Calls calls will be accepted according to the selected Filter.
Filtered calls will be ignored/rejected according to the Cause Value for Rejected Calls setting.

When you have set up a number filter for this port you can refine this by selecting Specific
numbers. The refinement can be configured on the List of MSNs or Dial-In Numbers page.

List of MSNs

T Pl 18 e

On this page you can specify for each configured MSN if it should be signaled for this service.
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Dial-In Numbers
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On this page you can select the range of extensions on which calls should be selected for this
service. Please make sure that the specified lowest and highest extension lie inside the configured
extension range for this port!
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ISDN over LAN

The RMTCAPI daemon and the RMTCONFIG application enable you to share ISDN ad-
apters over a TCP/IP network. To enable sharing you need to start the RMTCAPI daemon on
those PCs with ISDN hardware. Other PCs can be set up to access the shared adapters by using
RMTCONFIG.

Simply install the driver software on the additional PCs as described under Installation. Then run
RMTCONFIG or CRMTCONFIG as described below.

RMTCAPI

MS Windows

RMTCAPI is installed as a Windows service. Because of that it can not be installed on Windows
98 or Windows ME. After installing the daemon it will be available even after rebooting the PC
unless you deinstall it again.

Linux

On Linux RMTCAPI is implemented as a daemon process. To enable RMTCAPI automatically
when booting the PC you have to modify the corresponding init files (see the documentation of
your Linux distribution).

Installation
Enter
rmtcapi -i

atacommand prompt to install and start RMITCAPI. The service will accept inbound connections
on port 4711 on every IP address available on this PC.

To select a different port use the —p option. The command
rmtcapi -i -p 4712
installs RMITCAPI and will accept connections on port 4712 instead of 4711.

On PCs connected to the internet it may be necessary to make RMTCAPI listen only on specific
IP addresses. These addresses can be specified on the command line:

rmtcapi -i -p 4711 192.168.0.1

This way RMTCAPI will accept inbound calls only on port 4711 of address 192.168.0.1.

Deinstallation

The command
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rmtcapi -u

will deinstalliert RMTCAPI. The program will be unloaded (Linux) or stopped (Windows) but it
will not be removed so it can be restarted later on.

RMTCONFIG

RMTCONFIG configures PCs to use a shared ISDN adapter of a different PC.

In order to use a shared adapter simply check Use remote CAPI and enter an IP address and port
(i.e. 192.168.0.1:4712) where a RMTCAPI daemon can be reached.

To use local ISDN adapters simply uncheck Use remote CAPI again.

CRMTCONFIG

CRMTCONFIG is a command line version of RMTCONFIG and enables you to include it in
batch files (Windows) or shell scripts (Linux) or other automated processes.

The command

crmtconfig -1 192.168.0.1:4712

enables access to the RMTCAPI service reachable on port 4712 of the PC with IP address
192.168.0.1.

The command
crmtconfig -u

enables access to local ISDN adapters.

RMTCONFIG and DNS

When your local network is configured for DNS you can use DNS names instead of IP addresses
when configuring shared ISDN access.

CAPI Extensions

The following chapters describe extensions to the CAPI standard the PrimuX drivers offer. These
informations only will be useful for software developers.
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NT Mode

The NT Mode can be enabled on supported adapters using CAPICFG. The port settings (Switch
Type, TEI etc.) retain their meaning in NT Mode. This way it is possible to create PTMP and PTP
ports.

Simple

When set to NT - Network Termination [simple] the driver will handle all NT peculiarities by
itself so you can use standard applications. The driver will even generate progress tones at the
appropriate times.

When a connected terminal is picked up the application will receive a CONNECT IND message.
Dialed digits will be signalled using INFO_IND messages. When the application sends an ALERT -
REQ message the terminal will hear a calling tone, after sending a CONNECT RESP message the
connection will be established. From the applications point of view this looks exactly like an
inbound call on a DDI line (if your application isn't DDI capable you can even use the CAPI
filtering mechanism to let it collect all digits and present the application with a complete
number).

An 'outbound' call can be created by sending a CONNECT REQ message. The application will
receive the usual INFO_IND messages (i.e. when a terminal is ringing) and a CONNECT _ACTIVE -
IND message when a terminal answers the call. The driver even handles PTMP situations where
more than one terminal reacts to the call. From the applications point of view this behaviour
looks exactly like an outbound call in TE mode.

Full

When set to NT - Network Termination [full] the above mentioned translation layer will be
switched off. This way the application software can control every aspect of the connection.

Connections initiated by a terminal

A connection initiated by a terminal will be signalled with a CONNECT IND message. The
application must check the parameters of this message and generate a SETUP_ACK message on
the D channel immediately (see INFO_REQ below). By using the Early B3 Connect mechanism the
application can connect to the B channel before actually establishing the connection in order to
send a customized dial tone.

Digits dialed by the terminal will be signalled using INFO_IND messages. \When the application
decides that the number is complete it can send a CALL_ PROCEEDING message on the D channel
(see it INFO_REQ below). This message informs the terminal that it must not send any more digits.
Later on the application sends an ALERT REQ message and again generates progress tones using
DATA B3 REQ messages (when enabled via Early B3 Connect). When the application terminates
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the connection by sending a DISCONNECT REQ message it has to generate a busy tone by itself,
too.

Connections initiated by the application

In this case almost no special handling is necessary. Only when the application terminates the
connection it has to generate a busy tone for the terminal.

Early B3 Connect

In NT Mode the Early B3 Connect mechanism can be used after receiving a CONNECT IND
message. As in TE Mode a DISC message on the D channel won't send a DISCONNECT IND
message to the application. Instead the application has to interpret the INFO_IND message and
send a DISCONNECT_REQ message after a DISC is detected.

INFO_REQ message

The Additionalinfo structure has been expanded:

e The SendingComplete element controls generation of additional D channel messages
when used in an INFO_REQ message:

2 sends a SETUP_ACK message on the D channel
3 sends a CALL_PROCEEDING message on the D channel
4 sends a PROGRESS message on the D channel
e The driver supports Dynamic TEl selection according to CAPI AK-175 V1.0 (rev.05)

(09.04.2002). Because of this the DTEIS structure has to follow after the SendingCom-
plete structure (it can be of length 0, though).

e Next is a Progress structure. When the application wants to generate its own progress
tones this structure should contain 0x02 0x81 0x88 (i.e. length 2, data 81 88). This tells
the terminal that progress tones are available.

e last is a Display structure which allows the application to control the display of the
terminal. ATTENTION: Be careful when using this as some PBX's tend to crash due to
buggy handling of these display messages.
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